Creo Elements/Direct Modeling Installation and Configuration
Creo Elements/Direct 18.0
Creo Elements/Direct Modeling
Contents

Creo Elements/Direct Modeling 18.0: Installation and Configuration.................................5
System Requirements ........................................................................................................6
Software and License Requirements ...............................................................................6
Install Creo Elements/Direct Modeling ........................................................................6
Install multiple versions of Creo Elements/Direct Modeling in parallel ......................7
Uninstall Creo Elements/Direct Modeling ....................................................................8
Customize Creo Elements/Direct Modeling User Interface on Windows ....................8
Release notes ...............................................................................................................8
COM/.NET Application Programming Interface (API)..................................................8
Configure Creo Elements/Direct Modeling ..................................................................9
Configure Integrated Creo Elements/Direct Modeling Applications ..........................15
.NET Framework Installation .......................................................................................20
If You Have a Problem .................................................................................................20
This document describes how to install Creo Elements/Direct Modeling on Windows XP® Professional, Windows Vista®, or Windows® 7.

This document will not teach you how to install and use Windows XP® Professional, Windows Vista®, or Windows® 7. Please refer to the original Microsoft documentation where needed.
System Requirements
A detailed listing of the system requirements can be found at:
http://www.ptc.com/products/creo-elements-direct/modeling

Software and License Requirements
You need the following software and licenses to run Creo Elements/Direct Modeling:

• Software:
  ○ Graphics drivers (with OpenGL support)

• Licensing:
  ○ Creo Elements/Direct License Server 18.0 or higher

Install Creo Elements/Direct Modeling
Before you start the installation, verify that no other version of Creo Elements/Direct Modeling is running.

If you already have earlier released versions of Creo Elements/Direct Modeling (for example, CoCreate Modeling 17.0) installed, Creo Elements/Direct Modeling 18.0 will be installed in addition to your earlier released version.

If you already have an older version of Creo Elements/Direct Modeling 18.0 installed, the installer will automatically upgrade your existing installation. You do not need to remove the older Creo Elements/Direct Modeling 18.0 version.

If you do not want an automatic upgrade of your previous version of Creo Elements/Direct Modeling 18.0, please follow the instructions below in Install multiple versions of Creo Elements/Direct Modeling in parallel on page 7.

If you install the same version of Creo Elements/Direct Modeling, you can choose to modify, repair, or remove your existing installation.

Install Creo Elements/Direct Modeling as follows:
1. Log on as a user with administrator privileges.
2. Insert the DVD.
3. Double-click the file DVDSetup.exe.
4. Follow the instructions in the installation procedure.

5. When the installation is complete, you can find Creo Elements/Direct Modeling in the Start ▶ Programs ▶ PTC ▶ Creo Elements Direct Modeling menu.

Install multiple versions of Creo Elements/Direct Modeling in parallel

Typically, only one version of Creo Elements/Direct Modeling will exist on your system. During a regular installation, the existing version is upgraded automatically to the new version. However, you may want to keep multiple versions of Creo Elements/Direct Modeling in parallel on the same system (for example, for test purposes). To allow this mode, use the alternative way of installing the software.

Install Creo Elements/Direct Modeling in addition to an existing installation as follows:

1. Log on as a user with administrator privileges.
2. Insert the DVD.
3. Double-click the file setup_parallel.exe, located in the sub-folder Modeling and Drafting\3D CAD\Modeling.
4. Follow the instructions in the installation procedure.

Note

If Creo Elements/Direct Modeling is installed this way, the installation cannot be upgraded or patched at a later time. This instance of Creo Elements/Direct Modeling can be distinguished from a normally installed version by its name in Add or Remove Programs, or in the Start Menu. The name contains the exact version as a postfix (for example, "Creo Elements/Direct Modeling 18.0 - 18. 0.0. x"). It is strongly recommended that you install with setup.exe for normal use.

You cannot install the same version multiple times. If you uninstall a version that has multiple copies, registry entries required for the proper operation of its siblings may be deleted.
Uninstall Creo Elements/Direct Modeling

*Caution*

The following commands will remove all files delivered with Creo Elements/Direct Modeling. Any additional files that you have created will not be removed. However, if you have modified any of Creo Elements/Direct Modeling files, they WILL be removed. Make copies of the modified files or save them before proceeding.

Uninstall Creo Elements/Direct Modeling as follows:

1. Open the Control Panel.
2. Click Add or Remove Programs.
3. Select *Creo Elements/Direct Modeling 18.0* in the Add or Remove Programs dialog.
4. Click Add or Remove to uninstall Creo Elements/Direct Modeling.

Customize Creo Elements/Direct Modeling User Interface on Windows

User interface customization data is kept in the personal customization directory. This directory is created in the user's profile directory. The default location is

<application data path>\PTC\Creo Elements Direct Modeling <major version>\<major version>.<minor version>.

Release notes

For more information, please read the Release Notes document that is installed in

Start ▶ Programs ▶ PTC ▶ Creo Elements Direct Modeling 18.0. This file contains last-minute information.

COM/.NET Application Programming Interface (API)

The tools and documentation for the COM/.NET API are now available in Creo Elements/Direct Modeling. The tools, help, and a README file (COM.NetApiReadme.pdf) are located in

<Your Creo Elements/Direct Modeling folder>\common\COM_.NET_API_SDK.
Configure Creo Elements/Direct Modeling

This section describes how to configure Creo Elements/Direct Modeling including:

- Choose the Graphics Board Configuration on page 9
  - Hardware versus Software Rendering on page 9
- Define an Editor on page 10
- Set Up Creo Elements/Direct License Server on page 10
- Blocked Passwords on page 12
- Configure Creo Elements/Direct License Server Clients on page 14
- Activate Creo Elements/Direct Modeling Modules on page 14
- Run Creo Elements/Direct Modeling on page 14

*Note*

*Editing Configuration Files:* The Notepad editor does not handle UNIX-style line endings correctly; the whole file will be displayed as one line. We recommend Notepad++ or another text editor that handles these line styles correctly.

Choose the Graphics Board Configuration

To run Creo Elements/Direct Modeling, you should use a resolution of at least 1024x768 pixels and a color depth of at least 15 bits to produce more than 32768 colors. Consult the documentation supplied with your graphics board about supported resolutions and color depths in 3D mode.

Hardware versus Software Rendering

Hardware rendering means that 3D graphics operations are accelerated by specific 3D graphics hardware in your system. Software rendering means that 3D graphics operations are done in software, that is, using your PC's main processor.

In general, hardware rendering is the preferred mode as it gives better performance than software rendering. Be aware that in the hardware rendering mode you are actually using the specific 3D graphics driver which comes with your board, and you might see different behavior than with software rendering. If you encounter problems with your graphics driver, you can sometimes work around them by switching to software rendering, so that the 3D acceleration is not used.

Creo Elements/Direct Modeling automatically tries to find an appropriate display mode with hardware acceleration turned on at the current resolution.
Define an Editor

Creo Elements/Direct Modeling 18.0 supports Unicode. Not all text editors handle Unicode text files correctly. See the topic Unicode: Edit Unicode text files in the help for more details. Creo Elements/Direct Modeling contains a reference to a customized version of the open-source editor Notepad++, which correctly handles Unicode files. Notepad++ is a separate install option; this package includes a reference to the open-source Notepad++ editor and syntax highlighter files for Creo Elements/Direct Modeling Lisp and the Creo Elements/Direct Drafting macro language.

If Notepad++ is installed on your system, Creo Elements/Direct Modeling uses it as its default external editor.

You can also define any other text editor of your choice using the environment variables EDITOR or SDEDITOR. SDEDITOR takes precedence over EDITOR. Assuming that your preferred editor is installed as C:\Program Files \SomeEditor\editor.exe, follow these steps to define it as the default text editor for Creo Elements/Direct Modeling:

1. Open the Control Panel. Click Start ▶ Settings ▶ Control Panel.
2. Double-click the System icon.
3. In the System Properties dialog, click the Advanced tab, then click Environment Variables.
4. For Variable enter EDITOR or SDEDITOR.
5. For Value enter C:\Program Files\SomeEditor\editor.exe.
6. Click OK.

Set Up Creo Elements/Direct License Server

Creo Elements/Direct License Server provides software security for Creo Elements/Direct Modeling. It is installed on a single PC or workstation, which issues licenses to other systems running Creo Elements/Direct Modeling.

For more information, see the Creo Elements/Direct License Server Help.

Obtain Your Password

Creo Elements/Direct Modeling is password-protected. To run, each Creo Elements/Direct Modeling module requires a password on the license server PC.

You can obtain your passwords from the Internet-based License and Upgrade Delivery Service at http://www.ptc.com/support/cocreate.
To access this area, you need your customer number and an access password, found on the PTC order acknowledgement.

Find your product data and enter the physical ID of your security device. The password will be returned online immediately.

The password-protected software modules of Creo Elements/Direct Modeling are:

- Creo Elements/Direct Modeling (Upgrade password-protected)
- Creo Elements/Direct Sheet Metal (Upgrade password-protected)
- Creo Elements/Direct Finite Element Analysis (Upgrade password-protected)
- Creo Elements/Direct Surfacing (Upgrade password-protected)
- Creo Elements/Direct Advanced Design
- Creo Elements/Direct Mold Base
- Creo Elements/Direct 3D Library
- Creo Elements/Direct Part Library
- Creo Elements/Direct Cabling
- Creo Elements/Direct Interface for CATIA V4
- Creo Elements/Direct Interface for Creo Elements/Pro
- Creo Elements/Direct Interface for I-deas
- Creo Elements/Direct Interface for Inventor
- Creo Elements/Direct Interface for Unigraphics NX
- Creo Elements/Direct Interface for SolidWorks
- Creo Elements/Direct Interface for SolidEdge
- Creo Elements/Direct Interface for XVL
- Creo Elements/Direct Interface for Adobe 3D PDF
- eDrawings Professional for Creo Elements/Direct Modeling

**Start Creo Elements/Direct License Server**

In order to run Creo Elements/Direct Modeling, Creo Elements/Direct License Server must be registered and started. Generally, you will skip this section because Creo Elements/Direct License Server starts automatically. You will need only to start Creo Elements/Direct License Server if something went wrong or if you explicitly stopped it.
1. To open the Creo Elements/Direct License Server menu select Start ▶ Programs ▶ PTC ▶ Creo Elements Direct License Server 18.0.

2. To register Creo Elements/Direct License Server, click Register License Server in Control Service.

3. To start Creo Elements/Direct License Server, click Start License Server in Control Service.

Please note that with this button sequence, Creo Elements/Direct License Server will start automatically whenever Windows restarts. To prevent this behavior:


2. Select Creo Elements/Direct License Server.

3. Click the Startup button.

4. Select the Startup Type Manual and click the OK button.

5. Click the Start button.

**Blocked Passwords**

Creo Elements/Direct License Server rejects blocked passwords.

Blocked passwords are passwords which are marked as "blocked" in the Creo Elements/Direct license database. Passwords are usually blocked if they are split or moved to other license servers during a password exchange process.

No operations can be performed on blocked passwords.

**Obtain and Release Licenses**

Creo Elements/Direct License Server issues available licenses to users who want to run Creo Elements/Direct Modeling; it releases the licenses when they exit Creo Elements/Direct Modeling.

The following conditions must be met to obtain a license:

- The password must be located in the configuration file (default is MEls.conf) on the Creo Elements/Direct License Server PC or workstation.

- The number of users permitted by a specific password must not be exceeded. If it is, the user requesting the license must wait for the next available license.

Under different circumstances, Creo Elements/Direct License Server responds to requests for licenses as follows:

<table>
<thead>
<tr>
<th>License is available:</th>
<th>Creo Elements/Direct Modeling appears on the user's PC or workstation screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>All licenses are in use:</td>
<td>Creo Elements/Direct Modeling will not run.</td>
</tr>
</tbody>
</table>

---

12 Creo Elements/Direct Modeling Installation and Configuration
<table>
<thead>
<tr>
<th>The user's PC or terminal is idle for more than 3 hours:</th>
<th>Creo Elements/Direct License Server releases the user's license after 3 hours; it is then available for other users.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The network connection breaks:</td>
<td>Creo Elements/Direct Modeling tries to re-establish the broken connection with the License Server every five seconds and displays a dialog box. You can choose to wait until a license becomes available, or you can exit Creo Elements/Direct Modeling by clicking Exit and then confirming the exit.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Clicking Exit and then Confirm will cause Creo Elements/Direct Modeling to terminate without saving your data! Save is available only when the Security dialog box opens for the first time after the connection with the License Server is broken.</td>
</tr>
<tr>
<td>The PC running Creo Elements/Direct Modeling hangs or is switched off:</td>
<td>Creo Elements/Direct License Server immediately releases the user's license.</td>
</tr>
<tr>
<td>The user exits Creo Elements/Direct Modeling or terminates the Creo Elements/Direct Modeling process:</td>
<td>Creo Elements/Direct License Server immediately releases the user's license; it is then available for other users.</td>
</tr>
</tbody>
</table>

**Monitor the Creo Elements/Direct License Server Activity**

The Creo Elements/Direct License Server activity is recorded in an event log file. This file contains a record of the licenses granted and released for different hostnames and certificates, and it lists the errors encountered while Creo Elements/Direct License Server is running.

To check that the Creo Elements/Direct License Server is running and that licenses have been granted,

1. Click **Start** ➔ **Programs** ➔ **Administrative Tools** ➔ **Event Viewer**.
2. Click **Log** and select the **Application** option.

You can also display the Creo Elements/Direct License Server information in your Web browser:
1. Click Start ▶ Programs ▶ PTC ▶ Creo Elements Direct License Server 18.0 ▶ Status License Server.
2. Your HTML-browser pops up showing the required information.

**Configure Creo Elements/Direct License Server Clients**

Each PC or workstation in your network running Creo Elements/Direct Modeling needs to know the name of at least one host on which the license server is running.

The installation program prompts you to enter the list of names of the Creo Elements/Direct License Server hosts used by Creo Elements/Direct Modeling. Enter the name list as follows:

```plaintext
host1, host2 ...
```

If you want to change the name list of Creo Elements/Direct License Server hosts later, use Windows Control Panel ▶ Add or Remove Programs. Highlight Creo Elements/Direct Modeling <version> and click Change to launch the Installshield Wizard. Click Next until you see the License Server page, where you can make the necessary changes to the name list.

**Activate Creo Elements/Direct Modeling Modules**

Creo Elements/Direct Modeling allows the user to interactively load or unload modules. Each module needs an available license. If there is no license available for the selected module, an associated message opens. When the user unloads a module, its license is released and made available for another user.

**Run Creo Elements/Direct Modeling**

Now you are ready to run Creo Elements/Direct Modeling:

1. Click Start ▶ Programs ▶ PTC ▶ Creo Elements Direct Modeling <version>.
2. Click Creo Elements Direct Modeling <version> (language).

**Using the International Versions of Creo Elements/Direct Modeling**

During custom installation, you can select which language versions of Creo Elements/Direct Modeling you want to install. The English version always installs, but you can also install other language versions. If you install other language versions, the Creo Elements/Direct Modeling menu will contain an entry for each version.
Configure Integrated Creo Elements/Direct Modeling Applications

This section describes the configuration of the following integrated Creo Elements/Direct Modeling applications:

- Configuring Creo Elements/Direct Sheet Metal on page 15
- Install and Configure the Creo Elements/Direct Modeling Server (Remote Server Update Module) on page 17
- Configure Creo Elements/Direct Finite Element Analysis on page 19
- Install the Creo Elements/Direct Interface for Creo Elements/Pro on page 19
- Install the Creo Elements/Direct Interface for I-deas on page 19
- Install the Creo Elements/Direct Interface for Unigraphics NX on page 19

Configuring Creo Elements/Direct Sheet Metal

You can configure the Sheet Metal Technology Data Base (TDB), including the sheet metal settings.

To configure the default settings

Change your directory to folder:

<Your Creo Elements/Direct Modeling folder>\personality\sd_customize\SheetAdvisor

Copy the sha_customize file in this directory to your local corp, site, or user customization directory. See corp, site, user customization information in the general customization manual.

If you do not copy the file, your configuration changes will be overwritten when you install a new revision of Creo Elements/Direct Sheet Metal.

Use an ASCII editor to edit the sha_customize file as follows:

- Locate the settings you want to change, for example the units setting (UNITS 1:mm).
- To change the units setting, for example to inches, edit the line to (UNITS 1:inch).
- Save the file and exit.

Note

Changing the units setting in Creo Elements/Direct Sheet Metal also overwrites the units setting of Creo Elements/Direct Modeling.
To configure the Creo Elements/Direct Sheet Metal Technology Data Base files

When working with Creo Elements/Direct Sheet Metal, you need to configure your own Technology Data Base (TDB) files.

The following demonstration TDB files are delivered with Sheet Metal:

- sha_shopstable.lsp
- sha_demoshop.lsp
- sha_demoshop_func.lsp
- sha_costmodel.lsp
- punch_fncs/sha_punch_functions.lsp
- punch_fncs/sha_stamp_functions.lsp

These files are found in the folder

<Your Creo Elements/Direct Modeling folder>\personality\sd_customize\SheetAdvisor\%

For localized versions of the same files see the subfolders personality \german, french, italian, japanese. Note that the files sha_punch_functions.lsp and sha_stamp_functions.lsp have no localized versions.

To configure the TDB files you proceed as follows:

1. Create a new folder for your own TDB files. For example C:\users 
<archive>\data\%

2. Copy the demonstration TDB files to the new folder.

   You may, for example, copy all Lisp files (*.lsp) from the personality \german\sd_customize\SheetAdvisor\ folder to the C:\users 
<archive>\data\ folder.

3. Change to the new folder C:\users\archive\data\ and rename the sha_demoshop.lsp file to, for example my_fabrication_shop.lsp.

4. Customize the fabrication shop file according to your manufacturing needs. For details, see the Sheet Metal documentation, especially the administration guide, or the online help. You can also view the descriptions and examples in the demoshop files.

5. Specify the correct path and filenames for your TDB files in the sha_customize file.

Note

When modifying the demonstration TDB files, or adding your own fabrication shop files, you must save the files with different names. Otherwise your changes will be overwritten and lost when you install a new version of Sheet Metal.
Install and Configure the Creo Elements/Direct Modeling Server (Remote Server Update Module)

The Remote Server Update functionality is supported on the following hardware platforms:

- Windows XP® Professional (Microsoft)
- Windows XP® Professional 64-bit Edition (Microsoft)
- Windows Vista® (Microsoft)
- Windows Vista® 64-bit Edition (Microsoft)
- Windows® 7 (Microsoft)
- Windows® 7 64-bit Edition (Microsoft)

Make sure there is enough disk space in the cache directory. Install Creo Elements/Direct Modeling Server as follows:

1. Log on as a user with administrative privileges.
2. Insert the DVD.
3. Double-click the file SETUP.exe, located in the Modeling and Drafting subfolder.
4. Follow the instructions in the installation procedure.

The installation automatically starts the Windows service for Creo Elements/Direct Modeling Server. Make sure your firewall does not block the server.

Install and Configure the Dispatcher

Install Creo Elements/Direct Dispatcher as follows:

1. Log on as a user with administrative privileges.
2. Insert the DVD.
3. Double-click the file SETUP.exe (located in the Modeling and Drafting subfolder).
4. Follow the instructions in the installation procedure.

When the installation is complete, you can start Creo Elements/Direct Dispatcher in Start ▶ Programs ▶ PTC ▶ Creo Elements Direct Dispatcher<version>.

To add a server to the list:

1. Click View.
2. Click Server.
3. Type the server name in the Add Server field.
To configure the port assignments:

1. Click **Administration**.
2. Click **Configure**.
3. Type the client port number in the **Client Port** field. The default number is 2310.
4. Type the server port number in the **Server Port** field. The default number is 2309.
5. If necessary, change the value of the **Update Interval**.
6. If necessary, change the path of the **Cache Directory**.
7. Click **OK** to accept your settings and close the menu.

The additional commands under **Administration** let you do the following:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspend Dispatching</td>
<td>Suspends dispatching of new requests.</td>
</tr>
<tr>
<td>Resume Dispatching</td>
<td>Resumes dispatching of requests.</td>
</tr>
<tr>
<td>Stop Accepting Requests</td>
<td>Stops accepting new requests but continues with requests in progress.</td>
</tr>
<tr>
<td>Resume Accepting Requests</td>
<td>Resumes accepting new requests.</td>
</tr>
</tbody>
</table>

- To enable a server, highlight the server and click **Enable**.
- To disable a server, highlight the server and click **Disable**.
- To remove a server from the list, highlight the server and click **Remove**.
- To cancel a job, highlight the job and click **Cancel**.

**Troubleshoot the Dispatcher**

**Checking Port Assignments**

If the remote functionality is not working correctly, the most likely problem is incorrect port assignments between client-dispatcher-server. Check the following:

- Server not running!
  
  In the file `%SYSTEMROOT%\system32\drivers\etc\services`, check that the following entry is correct:
  
  ```
  SDserver(version) 2309/tcp
  ```

  The number 2309 is the port assigned to communicate between the dispatcher and the server and must be identical to the number in the **Port** data entry field in the **Dispatcher** menu. If this port is already in use, select an unused port and make sure you change the assignment in the **Dispatcher** menu.
Also, check in the Control Panel whether the service **SDserver** is running, otherwise install and start the following service program:

```
<Your Creo Elements/Direct Modeling Server folder>\SDserver.exe -install
```

**Use Network Administration Tools**

If you are using networking administration tools, make sure that the tool supports local naming entries. This is because the default for the server port number in the dispatcher is 2309. Some network administration tools may ignore this port assignment and the dispatcher is then unable to connect to the server.

**Configure Creo Elements/Direct Finite Element Analysis**

To configure Creo Elements/Direct Finite Element Analysis, please refer to the Help Center:

In the Table of Contents, click **Documentation for advanced users** ▶ **Finite Element Analysis** ▶ **Configuration**.

**Install the Creo Elements/Direct Interface for Creo Elements/Pro**

If you install the Creo Elements/Direct Interface for Creo Elements/Pro, the **plugin_start.html** file describes how to register the adapter on the Creo Elements/Pro side. The default location for this file is:

```
<Your personal installation directory>\Direct CAD Interfaces 18.0\Creo Elements Pro\documentation\n```

**Install the Creo Elements/Direct Interface for I-deas**

If you install the Creo Elements/Direct Interface for I-deas, the **plugin_start.html** file describes how to register the adapter on the I-deas side. The default location for this file is:

```
<Your personal installation directory>\Direct CAD Interfaces 18.0\IDEAS\documentation\n```

**Install the Creo Elements/Direct Interface for Unigraphics NX**

If you install the Creo Elements/Direct Interface for Unigraphics NX, the **plugin_start.pdf** file describes how to register the adapter on the Unigraphics NX side. The default location for this file is:
.NET Framework Installation

To run Creo Elements/Direct Sheet Metal module, add-in applications, or clients that are based on Creo Elements/Direct Modeling's .NET API, you are required to install the Microsoft® .NET Framework revision 4.0 or higher.

If you install Creo Elements/Direct Modeling from the DVD, the installation procedure will automatically check the .NET Framework installation prerequisites and initiate the installation accordingly. It is highly recommended to install the .NET Framework manually as described below if it has not been installed automatically; this could have been caused by:

- The .NET Framework installation prerequisites are not met.
- The .NET Framework installation has been cancelled.
- Creo Elements/Direct Modeling is directly installed from a download package.

Access the Installation Package

The installation package (32–bit and 64–bit) is located on the installation DVD under Modeling and Drafting\Prerequisites\win\NetFx40_x86_x64.exe, or you can directly download the package from Microsoft.

Installation

For installation just run the install package; the installation of the .NET Framework requires Administrator privileges.

If you install the .NET Framework after installing Creo Elements/Direct Modeling, re-register the application by calling the following command:

<Your Creo Elements/Direct Modeling folder>\binNT\SolidDesigner /register

The above command must be issued from a command prompt window.

If You Have a Problem

This section describes problems you might encounter when installing or using Creo Elements/Direct Modeling. In each case, the appropriate remedial action is given.

It also describes how to send feedback and report problems.
• Sending Feedback and Reporting Problems on page 21
• File Transfer between UNIX and PC on page 22
• Not Enough Memory on page 23
• Graphical Performance Deficiencies on page 24
• Lengthy Creo Elements/Direct Modeling Computation on page 25
• Insufficient Disk Space on page 25
• Installation Issue “Please insert disk: 1” on page 26
• Handling Large Amounts of Data on page 26

Sending Feedback and Reporting Problems

PCs are installed in a wide variety of configurations. Therefore, it is important that you provide configuration data with any support request. This will help us to verify and solve the problem.

To submit a report, please use your standard support contact.

PC configuration

Save a configuration report to a file using the Windows Diagnostics tool:

2. Select Save Report or Print Report in the File menu depending on whether you want to send the report using email or fax.
3. Make sure you select All tabs as the scope and Complete as the detail level of the diagnostic output.

If for some reason you cannot provide such an automated report, make sure that your report contains the following data:

• Type of graphics board used, including its memory configuration
• Display resolution and number of colors; driver version number if the problem is display-related (to find out the driver version number, click the right button over a free area on the desktop, choose Properties, select the Settings menu and click on Display Type)
• Amount of main memory and swap space
• Processor type
• Network card used; driver version and network configuration if the problem is network-related (the license server requires a proper TCP/IP installation)
• Active services
• Any special things you had to do on your PC to get Creo Elements/Direct Modeling installed
• Non-standard environment variables

Creo Elements/Direct Modeling version information
• Version number as displayed in the Creo Elements/Direct Modeling Copyright screen
• File date (should be sufficient in most cases)
• Size of the .exe file

Files needed to reproduce the problem
• Any customization files you use (such as sd_customize)
• Recorder files
• Creo Elements/Direct Modeling data files

Customization directories used
• Click Edit ▶ Settings ▶ UI Settings ▶ Customizations ▶ Show Directories and send us the contents of the output box.

File Transfer between UNIX and PC
Files and path names on a PC differ from their counterparts on UNIX workstations. There are different file name and path name conventions, and ASCII files use different end of line definitions.

Symptoms
• UNIX-style ASCII files are not displayed correctly.
• Filenames change during transfer.
• Path names are not understood.

To solve this problem

ASCII files
On a PC, lines end with a <CR> <LF> combination (where <CR> is ASCII 13 and <LF> is ASCII 10). On UNIX systems, lines end with <LF> only. Furthermore, special characters (such as umlauts) are encoded differently on the various UNIX platforms.
The Notepad editor cannot handle UNIX-style ASCII files. WordPad handles UNIX-style line endings better, but has known issues with UTF-8 files. We recommend using Notepad++.

Filenames

The conventions for filenames differ between PCs and UNIX workstations. This is mainly due to the influence of the FAT file system on PCs which originally only supported 8+3 filenames (that is, a basename of up to 8 characters plus an extension of 3 characters). When transferring files, you may encounter the following:

Creo Elements/Direct Modeling creates data files with 3- and 4-character extensions. Make sure you are transferring these files with programs which handle long filenames correctly. Some ftp clients, for example, support 3-character extensions only. The built-in Windows ftp client handles long filenames correctly.

Case is also significant in Creo Elements/Direct Modeling filenames. Make sure that any file transfer tools (such as ftp clients) preserve the case - the default Windows tools do.

Path names

Creo Elements/Direct Modeling on Windows understands both forward slashes and backslashes as path separators. In Lisp strings, backslashes must be “escaped”.

Examples:

```
personality/sd_customize/ANNOTATION
"personality\sd_customize\ANNOTATION"
```

Not Enough Memory

In certain circumstances Creo Elements/Direct Modeling may report that there is not enough memory available.

Symptoms

Creo Elements/Direct Modeling displays the following error message:

```
Not enough memory. Please store data and exit.
```

To solve this problem

1. Save the current model.
2. Restart Creo Elements/Direct Modeling.
Graphical Performance Deficiencies

Depending on your graphics board and whether you are working with hardware or with software rendering you may experience different problems in the graphics area.

For more details on the configuration see Choose the Graphics Board Configuration on page 9. This section provides you with hints and workarounds concerning the problems you might encounter.

Graphical Performance Symptoms

The graphical performance is not satisfactory when viewing shaded models.

To solve this problem
Check if the hardware acceleration is turned on. See Choose the Graphics Board Configuration on page 9 for details on how to find out whether it is turned on or off.

Viewport Symptoms

Creo Elements/Direct Modeling reports errors and freezes the viewport when you rotate certain parts.

To solve this problem
Make sure that hardware acceleration is turned on. There is a problem in Microsoft's OpenGL software renderer on certain configurations which may cause this behavior.
You can also work around the problem by turning 3D geometry edges off before loading or displaying the part. This is done in the Creo Elements/Direct Modeling Show menu.

Trail Symptoms

The mouse cursor and/or the feedback lines leave trails in the viewport as you move them.

To solve this problem
On some graphics cards, mouse shadows need to be disabled to fix the mouse trail issue. Open the Mouse control panel, open the Pointers tab, and uncheck the Enable pointer shadow option.
3D Geometry Display Symptoms
No 3D geometry displayed.

To solve this problem
Check that the Drawlist Browser is not empty and that 3D Geometry is not switched off in the Show menu. Click the Fit button.

Lengthy Creo Elements/Direct Modeling Computation
Sometimes it may be necessary to interrupt a lengthy Creo Elements/Direct Modeling computation.

Symptoms
Creo Elements/Direct Modeling does not come back after starting a command, but keeps showing the hour glass.

To solve this problem
All lengthy operations in Creo Elements/Direct Modeling are interruptible by pressing the [Break] or [Esc] key on your keyboard.
If this does not help, please report the case to PTC support.

Insufficient Disk Space
Insufficient disk space will cause the installation to fail.

Symptoms
Installation stops with a message saying "Not enough disk space".

To solve this problem
The installation program checks that the target filesystem has enough space for Creo Elements/Direct Modeling. On large FAT filesystems, however, the real disk space occupied by the installed Creo Elements/Direct Modeling can differ significantly from the sum of the Creo Elements/Direct Modeling file sizes. The installation program tries to take this into account, but is not always correct. Make sure that you install Creo Elements/Direct Modeling to a file system with sufficient disk space. A full Creo Elements/Direct Modeling installation requires up to 1.5 GB.
Installation Issue “Please insert disk: 1”

Symptoms
When trying to install a Minor Upgrade of Creo Elements/Direct Modeling 18.0 from a DVD, the installation fails with the message: “Please insert disk:1”.

To solve this problem
Copy the installation package to a local hard disk drive or to a network location and retry the installation.

Handling Large Amounts of Data
You want to use models in Creo Elements/Direct Modeling which exceed 2 GB in memory.

To solve this problem
Creo Elements/Direct Modeling can use as much memory as the operating system provides to the application. On 64-bit operating systems, this amounts to a virtual address space for the application of up to 8 terabytes.

On 32-bit platforms, the address space is limited to 4 GB, half of which is used by the operating system, so only 2 GB of virtual memory is addressable by the application. You can move the split line in virtual memory to 3 GB, that is, 1 GB is reserved for the operating system, while 3 GB are available to the application. This is done by configuring the operating system to run in the so-called “4GT RAM Tuning” mode.

This mode is enabled by adding the switch "/3GB" to entries in the boot.ini file. (In Vista and later versions, use the BCDEDIT tool). Details on the configuration are described in the release notes shipped with the above-mentioned operating systems. Microsoft also describes the configuration in a technical article titled "Memory Support and Windows Operating Systems" at http://www.microsoft.com/whdc/system/platform/server/PAE/PAEmem.mspx.

Alternatively, consult the Microsoft Knowledge Base article Q291988. The Microsoft Knowledge base can be accessed via their support web site at http://support.microsoft.com/.